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Digital Photography
Is it right for you?
Did you get a new digital camera for the holidays? Want to learn more about
digital photography before you purchase a new camera? In this newsletter |

hope to sort through the techno jargon that seems to surrounds all new
technologies. | hope to clarify the following topics about digital photography.

e What is digital photography?

e Buying a digital camera

 Resolution, megapixels, compression and image quality vs. file
size

¢ Image editing software

e Printing photos

¢ Online photo web sites

What is Digital Photography?

Think of a digital camera as a tiny computer with a lens and a memory card.
When the lens opens the image is stored on the memory card as a file the
same way a computer stores a written document as a file on your hard drive.
This file can then be transferred to your computer. Once on your computer you
can print it on a color printer, e-mail it to someone or transfer it to your web site
for all the world to see.

With digital photography you do not have to wait for your pictures to be
developed, your pictures are immediately available to you. All you have to do
is connect your camera to your computer (almost all digital cameras come with
a cable to connect it to your computer), press a few buttons, and like magic
your pictures are on your computer.

Most digital cameras come with a LCD (liquid crystal display) on the back of it
S0 you can see immediately if the picture is worth saving. If not, you can
delete it on the spot and save space on the memory card for better photos.
Since there is no film to buy and no film developing you will save the expense
of these two items and not waste money on bad pictures.
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Of course digital cameras have expenses of their own. Digital cameras cost
more than film cameras, use up batteries much faster and there are memory
cards to buy, but if you like to take a lot of pictures, in the long run digital
cameras will cost you less than regular film photography.

Now let's take a look at how to buy a digital camera
Next
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Buying a Digital Camera

When shopping for a digital camera your primary use for the camera will
determine what kind to get.

Megapixels

On page 3 | will define what a megapixel is but for now all you need to know is
that if you plan to take photos for the Internet, e-mail and web sites and print
only up to 4 x 6, then a 1 megapixel camera should be fine. If you want to print
your own photos up to size 5x7 then get a 2.1 megapixel camera. And if you
want to print your own 8x10's then get a 3.3 megapixel camera.

Memory Cards

There are many different kinds of memory cards, all with varying capacities.
The larger the memory card the more photos you will be able to store on it.
Memory cards work just like other computer storage mediums, like hard disks,
floppy disks, zip disks and re-writeable CD's. Memory cards can be used over
and over again. After you transfer your pictures to your computer the memory
card can be erased and you can store new pictures on it. Most memory cards
come in capacities of 8, 16, 32, 64 and 128 MB (megabytes). Sony even
makes a digital camera that will use a regular floppy disk to store pictures, but
beware, floppy disks hold only 1.44 MB which is not very much when storing
digital photos.

If you are going on a long trip and will not be able to transfer your pictures to
your computer until you get back home then you will want to purchase
additional memory cards. Another option on a long trip is to take a notebook
computer with you and every night transfer your pictures to it.

| Aprox photos per card

|Camera | 16MB | 32MB || 64MB | 128MB
|1 megapixel || 45 | 91 | 182 | 365
12 megapixel || 17 | 35 | 71 | 142

|3 megapixel || 13 I 26 | 53 I 106
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If you have any other devices that use memory cards you may want to stay with
the same type of memory card. Memory cards are interchangeable among
digital cameras, digital video cameras, MP3 players, notebook computers, etc.
Below are the typical digital camera memory cards.

e SmartMedia

Sanisk 2

1!06‘&3

CampactFlash

e CompactFlash

e Sony Memory Stick
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¢ Multimedia card
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e Floppy Disk

The connection to your computer

The easiest, but not necessarily the fastest, way to transfer pictures from the
camera to your computer is through a cable that connects to both your camera
and your computer. Most cameras come with the cable and you will want to
make sure that your new camera does. The two main cables are serial and
USB. All desktop computers and most notebook computers have a serial port,
but it is slower than USB. All new computers, built in the last 3-4 years, have a
USB port and this is the preferred cable connection, but it is not essential.
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Memory disk manufacturers also sell adapter kits that allow you to remove the
memory card from the camera and place it in the adapter. The adapter then
connects to the USB port and you have virtually the same connection as an
original USB camera cable. Actually, it turns out to be even better because you
do not have to use your camera (i.e. drain the batteries or plug in the AC
adapter) to transfer your pictures to the computer. Below is a picture of
adapters.

¢
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Batteries

Digital cameras eat up batteries very quickly. Look for a camera that comes
with rechargeable batterers and an AC charger, or at least one that can use
them if purchased separately.

Next, lets take a look at the image quality vs. file size issue.

Previous | Next
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Resolution, Megapixels, Compression and Image
Quality vs. File Size

Resolution and Megapixels

Resolution is a term used in graphics to measure the dots-per-inch of a picture.
Each dot is called a pixel. A megapixel is a million pixels. The more dots-per-
inch the high the resolution. The higher the resolution the larger you can print a
picture before you start to actually see the pixels that make up the photo. On
the down side, the higher the resolution the larger the picture file will be and
therefore the less pictures you can store on a memory card.

IResolution I Maximum print size |
less than 640 x 480/ jonly wallet-size prints recommended |
640 x 480 |/Absolute minimum resolution for 4x6 (results will vary)|
1024 x 768 IRecommended minimum resolution for 4x6 |
11152 x 864 IRecommended minimum resolution for 5x7 |
[1600 x 1200 |IRecommended minimum resolution for 8x10 |

Below are two links you can click on to see examples of the same picture in two
different resolutions. (Note: If you look at the pictures use your Browser's Back
button to return to this page.)

The first picture was taken at a 2048 x 1536 pixel resolution. Notice how large
the picture is without being able to see the pixels that make up the picture.

Picture #1 (File size is 388KB)

The second picture was taken at a 1024 x 768 pixel resolution. If you look
closely you can see that the picture is smaller and you can already see the
pixels that make up the picture.

Picture #2 (File size is 92KB)

You may be wondering why you see some blurriness. That is because | used
compression to reduce the file size. If | hadn't the file would be too large to
transfer over the Internet. As it is these file sizes take a long time to download
if you don't have a cable modem or DSL.
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Compression

If you want to store more pictures on your memory cards or if you want to send
your pictures over the Internet via e-mail or a web site then you will have to
compress the file. If on the other hand you only want to print your picture then
compressing it would degrade the printed quality.

Everything about computers is a trade-off and digital photography is no
exception.

| Resolution and Compression Trade-offs

| | Resolution | Compression | File size
IFor printing | High | Low | Large
For e-mail, web :

sites Low High Small

Tip: If you would like to be able to print high quality prints always take your
pictures in high resolution. You can always reduce the file size later with an
image editing program.

JPEG, Joint Photographic Experts Group, is the preferred method of
compression for the Internet. If you receive a file with the last three letters of
.JPG then you know it is a picture file and it has been compressed for the
Internet. Some digital cameras will save pictures automatically in JPG, but with
others you will need to use an imaging editing program.
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Image Editing Software

Once you have your picture on the computer, it is likely that you will want to
make some sort of change to it. From time to time you may want to:

¢ Resize the picture

Crop something out of the picture

Compress the picture

Remove red eye

and other more advanced enhancements

Most digital cameras (an expensive Nikon did not) come with image editing
software to perform all these tasks. A number of color printers and most
scanners also come with it. Some computer manufactures also include image
editing software with their new computers. Some of the more popular names
are:

e« Adobe Photoshop Elements

¢ Microsoft Picture It!

e Paint Shop Pro

e Ulead Photolmpact

Resize

One of the most common tasks is to resize your pictures. If you have a high
resolution camera you will want to resize your picture before you e-mail it to
someone. If you don't your recipient will not be able to see the entire picture in
one screen full. They will have to scroll the picture just to be able to see the
entire image.

Crop

Another common task is to cut part of the picture out. This is called cropping
the picture. Sometimes you may want to focus in on only part of the picture and
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remove the unnecessary part.
Compress

If you are going to e-mail the picture or place it on your web site you will want to
reduce the file size. Compression reduces the time it takes to send, receive or
download a picture, and everyone wants a faster Internet experience. The
down side to compression is that you loose image quality and if your recipient
wants to print the picture they will have a lower quality file to work with.

Tip: If your recipients are going to want high quality prints use an online photo
processing service (page 6). These services will use your original high quality
files to make prints and can be mailed directly to your family and friends.

When finished with your image editing software you will then want to print your
pictures. Next we will look at ways you can print your digital pictures and the
results will be every bit as good as the drug store prints.
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Printing Photos
Printers

Now that you have your pictures just the way you want them it is time to print

your masterpieces. Color printers have been available for a number of years

but until recently printing high quality prints to match film developing has been
costly.

There are many good color printer manufactures including:

e Epson

o Hewlett Packard

e Canon

e | exmark
Paper Type

The most important detail to improve your print output is to use photo paper and
change the printer setting accordingly. Most people do not realize this; you
have to manually change the printer settings whenever you use photo paper.
With out telling the printer that you have photo paper in it, the printer will think it
is printing on plain paper and use a lower print quality setting. This is because
plain paper can not absorb as much ink as photo paper can. When you tell the
printer that you are printing on photo paper it will use more ink to produce a
higher quality print.

Here is how you tell your printer what kind of paper you are printing on:
1. Click on the File menu
2. Click on Print
3. Click on Properties.

4. Now find where you select the Paper Type. Every printer is slightly
different so look around. It is usually on the Paper tab.
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Printing Multiple Pictures On A Page

One question | am often asked is how to print more than one picture per page.
Some image editing software programs as well as some printers will let you
print more than one picture per page. Photo papers come in all different sizes
and sometimes you will want to print two or three 4 x 6 prints per page. You
will have to look around to see if your image editing software or the printer
software allows for this. Look under the File menu for Printer Setup, Printer
Properties or Page Setup. Every software does it differently so look around for
the setting.

Tip: Every software program has a Help menu and in the drop down list is
usually a Contents and Index section. If you are not sure whether your
software prints mulitple pictures per page click on the Help menu and search
the contents for "printing".

If your image editing or printer software does not print more than one picture
per page then you can use a desktop publishing program like Microsoft
Publisher. Publisher lets you place any number of pictures on a page.
Another alternative is to download Kodak's EasyShare software. This software
can be used with any color printer to print more than one picture per page.

If you would rather not print your own digital pictures then you will want to use
an online service to print them for you. Click next to read how.
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Online Photo Processing

Another way to print your digital photos is to use an online photo processing
service. Some of the best web sites are:

e Shutterfl

e Snapfish
¢ MSN Photos

« Ofoto

With an online photo processing service you can upload (transfer a file from
your computer to theirs) a picture to them and they will print it and mail it back
to you. They can even mail prints to your friends and relatives. Some of these
services will also put photos on items like coffee mugs and t-shirts.

Online Photo Albums

Another benefit to these online photo services is the ability to save your pictures
in online photo albums. If you save your pictures in online albums then all your
family and friends can visit the album anytime they want. You will then save
time by not having e-mail individual pictures to everyone.

To see a sample of an online photo album visit my pictures of the 2001
Colorado Springs Balloon Classic.

Tip: If you would prefer to stick with traditional film cameras you can still get
some of the benefits of digital photography by having an online photo
processing service develop your film. Some of these services will develop your
film, return your negatives and post your pictures in your account ready for you
to make online photo albums and have prints made. It can be an economical
way to have your developing and prints made because you do not have to pay
for prints that you don't want.

Also, if you are an American Online user you can use AOL's You've Got
Pictures. When you drop off your film at the drug store check the box to have
your pictures sent to your AOL account. You will pay extra for the service but
all your pictures will be in digital form and ready to e-mail to family and friends.


http://www.pcworld.com/resource/browse/0,cat,44,sortIdx,1,00.asp
http://www.dpreview.com/
http://www.kodak.com/US/en/nav/digital.shtml
http://www.shortcourses.com/
http://www.photocourse.com/
http://www.digital-photography.org/
http://www.saltlake2002.com/
http://www.olympic.org/
http://www.winterolympics.com/
http://espn.go.com/oly/index.html
http://www.washingtonpost.com/olympics
http://www.nytimes.com/pages/sports/other/index.html
http://pctutor.com/tips/scandisk.htm
http://pctutor.com/tips/defrag.htm
http://pctutor.com/tips/av.htm
http://pctutor.com/tips/windowsupdate.htm
http://pctutor.com/newsletters/winter02/page5.htm
http://pctutor.com/newsletters/winter02/default.htm
http://www.shutterfly.com/
http://www.snapfish.com/
http://photos.msn.com/
http://www.ofoto.com/
http://www.shutterfly.com/my/osi.jsp?i=67b0de21b31f1f6805ce

Conclusion

| hope that you now have a better understanding of digital photography. | have
had my digital camera for a few months now and enjoy the fact that | can take
photos anytime | want without worrying about the cost of film or developing. |
also always have my photos available to e-mail family and friends and to post
on my web site.

Happy photos!
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Note: All photos in this newsletter were obtained from Microsoft's Online Clip Art Gallery.
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